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STUDENT PAGES 

Asiatic Black Bears: Conservation in Taiwan 

 

INSTRUCTIONS FOR ANALYZING DATA 

 
By now, you should have already developed hypotheses and corresponding predictions.  So, it’s time 

for Step 5 of the Scientific Process! 

 

1. Develop Hypotheses 

2. Use hypotheses to develop predictions 

3. Design a scientific study to rigorously evaluate predictions 

4. Collect data 

5. Analyze and evaluate data 

6. Use results from data evaluation to draw conclusions, and to inform new hypotheses 

7. Share findings with peers, scientists, and the public 

 

Because we have 2 different hypotheses to evaluate, we’ll provide 2 different sets of 

instructions for you.  

 

Hypothesis 1, we’ll provide Instructions for GIS Analyses.  For Hypothesis 2, we’ll provide 

Instructions for Habitat Use Analyses.   

 

Let’s get started with the GIS instructions. 

 

 

 

Instructions for Hypothesis 1:  GIS Analyses 

1. Open ArcMap  
If your school has a SCHOOL CAMPUS LICENSE for ESRI products, then you already have 

the necessary software at school required to use this lesson plan.  If your school does not 

have a SCHOOL CAMPUS LICENSE for ESRI products, then you can download the software 

“ArcGIS for desktop” for a free 60-day trial.  http://www.esri.com/software/arcgis/arcgis-

for-desktop/free-trial    

 
1. In the getting started window click New Maps on the left side.  With Blank Map 

chosen, hit OK. 
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2. Add Data 
1. Click Add Data in the toolbar.  All of the spatial layers are pre-loaded in the folder 

called ABBGIS_Spatial Data.  This folder is available through Bear Trust 

International; your teacher will give you instructions on how to access this folder.  

When you have the folder ABBGIS_Spatial Data, click on the following files to load 

them into your map.  Make sure you load only these files in the following order.   

 

1. FA7.shp 

2. MA11.shp 

3. MA13.shp 

4. MA8.shp 

5. MS6.shp 

6. YNP.shp 

 

2. Examine the Table of Contents that now has the layers for your map. Notice that 

each of the layers has a button to expand or minimize its data symbology and a box 

to uncheck/check to make the layer invisible/visible.   

 

3. Now load the next set of files.   

 

LOOK ->  Some of the following files are projected in a different geographic 

coordinate system than the previous shape files.  For some layers you might see this 

warning:  “Geographic Coordinate Systems Warning”.  When you see this, click 

Transfomrations.  Convert from “GCS_WGS_1984” Into “GCS_TWD_1967”. Click 

OK.  Click Close.  This will transform data layers on the fly into the coordinate 

system in which the previous set of files is already projected, which is important to 

ensure all the data are correctly displayed.    

 

1. countries.shp 

2. TWN_roads.shp 

3. TWN_water.shp 

4. species_22824.shp 

5. N23E120.hgt 

6. N23E121.hgt 
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3. Asiatic Black Bear Distribution 
1. Uncheck and minimize all the layers except for countries.shp and species_22824.  

2. Right click on the layer countries.shp and then click on label features.  This 

provides the names of the countries. 

3. Make sure that species_22824.shp is listed above the countries.shp layer in the 

table of contents. The layer’s visibility depends on their order in the table of 

contents, top to bottom.  Here’s how you move layers:  click the button on the far 

left under the “table of contents”.  This button is called “List by drawing order”. 

Then right click on a layer and drag the layer to a new position in the table of 

contents. 

4. Right click on the layer species_22824. When its toolbar opens up, scroll down  and 

click  Zoom To Layer.  This moves the map display to show the full extent of the 

data in this particular layer.  

The data in this layer are from the ICUN Red List of Threatened Species.  It is the 

species distribution of Asiatic black bears and when you open it up you will see several 

pale blue polygons. Let’s symbolize this layer differently to get a better understanding 

of the data.  

5. Right click again on the layer species_22824 and click Open Attribute Table. 

Examine the table and notice how similar the attribute table is to an excel file.  

Scroll to the right to the column called LEGEND. It holds the data that explains the 

differences in the pale green polygons.  Okay, now click the X in the top right corner 

to close the table.  

 

6. Right click again on the layer species_22824 and scroll down to click on Properties.  

a) Under the General tab, change  Layer Name to: Asiatic Black Bear 

Distribution. 

b) Let’s symbolize the different categories of data from the IUCN Red List.  

Under the Symbology tab, Choose Categories in the Show column to the left. 

Keep it on Unique Values and change the Value Field to LEGEND, and click 

Add All Values below it.  The columns explain the different values from the 

field LEGEND, as well as what each Label is on the map, the count of 

occurrences, and the color of the symbology.  

c) Unclick the row for the <all other values> because their count is 0. (This is a 

simple way to remove unneeded data from the map display without removing it 

from the data.) 

d) Change the Color Ramp to any option with at least four distinctly different 

colors.  
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e) Click OK when done. Examine the map.  

Note: when choosing colors for a map, be aware of your audience. Choosing colors 

based on personal preference may not be best for displaying differences on a map. 

Choose a wide array of colors in the same spectrum or hue.  Be aware that clashing 

colors might be distracting. 

f) To examine the different categories for any layer, click the Identify Tool on 

the toolbar (blue circle with an i). Then click on a point in the map to see its 

properties.  

 

4. Yushan National Park 
1. Uncheck the layer Asiatic Black Bear Distribution and countries.shp, and check the 

layer YNP.shp to make it visible.  

 

2. Under the General tab, change  Layer Name to: Yushan National Park. 

 

3. Zoom to the layer Yushan National Park.shp. This layer represents the boundary of 

the Yushan National Park. 

 

4. Find the Measure tool in the toolbars above or to the left.  Its icon is a ruler. 

Clicking on it open the measure window that explains the process of measuring a 

distance, area, or feature.  

a) Measure the feature ( the + icon) , the Yushan National Park layer.  

b) Change the units by clicking on the first downward facing arrow to the right 

of the + icon. You can change the units measured for the area and distance 

into kilometers, miles, acres, etc.  

 

5. We need to easily view the boundary of the park.  Change the symbology by using a 

shortcut: double click on the symbol of the layer in the Table of Contents. This opens 

up the Symbol Selector window and gives easy access to changes in color and outline.  

a) Change the Fill Color to no color 

b) Change the Outline Width to 6 

c) Change the Outline color to Black 

d) Click OK when done. 

 

6. Check the box in the table of contents to make visible TWN_roads.  TWN_roads 

actually includes roads and trails so let’s change the name of this layer to Taiwan 

Roads and Trails (hint, use the General tab).  We also need to use symbology to 
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distinguish between roads and trails.  Right click on Taiwan Roads and Trails and 

click  properties. 

a) Under the Symbology tab, Choose Categories in the Show column to the left. 

Keep it on Unique Values and change the Value Field to F_CODE_DES, and 

click Add All Values below it.  The columns explain the different values from 

the field F_CODE_DES, as well as what each Label is on the map, the count of 

occurrences, and the color of the symbology.  

b) Unclick the row for the <all other values> because their count is 0. (This is a 

simple way to remove unneeded data from the map display without removing it 

from the data.) 

c) Find the box with the column headers:  

      Symbol     Value     Label    Count 

Double click on “Road”.  Scroll down and click on “Major Road”, color black, 

size 1.5.  Click OK. 

In the same box, now double click on “Trail”.  Scroll down and click on “Dashed 

2:2”, color orange, size 2. 

d) Click OK when done. Examine the map.  

7. Check the box in the table of contents to make visible TWN_water.  Change the 

name to Taiwan Water.  Using the steps from #5 above, change the water layer to 

be bright blue , Size:2  These are all the rivers and streams in the Yushan Mountains.  

 

5. Elevation  
1. Uncheck and minimize all layers except Yushan National Park, N23E120.hgt, and 

N23E121.hgt. The two new layers are elevation levels for the longitude North 23 

and the latitudes East 120 & East 121.  

2. Different vegetation is associated with different elevations.  For this bear study, 

Dr. Hwang correlated different bear foods with different elevations.  Let’s 

symbolize the elevation ranges to represent different vegetation zones. Go to the 

Symbology tab in Properties for either of the layers.  

a) Explore the four options for Show: Unique values, Classifies, Stretched, and 

Discrete Color by clicking each and then Apply.  

b) Choose the option Classified. Change the Classes to 8 and click Classify.  

c) Change the break values to the following starting at the top: 500, 1000, 

1500, 2000, 2500, 3000, 3500, leaving the maximum elevation the same.  

It is easiest to begin with the 3500 and work your way up. Click OK when 

done. (hint:  make sure the values you entered are correct, you might have to 

redo some values). 
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d) Change the Color Ramp to a hue or shade of 1 color. Make sure 8 discrete 

colors are seen easily. 

e) To get rid the many 0000”s off the end of the Label, click on Label then 

format Labels. Change the rounding to Number of decimal places instead of 

Number of significant digits. Click OK when done.  

f) Click Ok when finished with the layer and do the same for the other 

Elevation layer.  Make sure the color ramp is the same as well.  

6. Bears 
1. Each bear has a unique set of location data (GPS and radio telemetry data).  In the 

following steps, you will be creating Minimum Convex Polygon home range boundaries 

for each of the 5 research bears that we will evaluate from this study.   

 

The 5 bears are:   

MS6 (Male subadult)    MA13 (Male adult) 

MA8 (Male adult)   FA7 (Female adult) 

MA11 (Male adult) 

Before you create home ranges for each bear, here’s some important information about 

home ranges: 

Animal home ranges can be estimated using several statistical methods.  The simplest way 

to create the boundaries of a home range is to draw the smallest possible convex polygon 

around the locations. This is called the minimum convex polygon (MCP) method.  Because 

this method tends to exaggerate the size of home ranges (e.g., the animal may not use all 

the spaces between the location points), other more complex mathematical tools have been 

developed. When data are available, most wildlife biologists also use other methods to 

calculate home ranges (example: Kernel Home Range, etc), but the MCP is useful as an 

introductory and comparative method and is the method we will use for the Formosan black 

bears. 

Okay, let’s make a home range for each bear individually.  Ladies first: 

 FA7 

a. Turn off all the layers except FA7.shp  

b. Change the color of FA7s points.  Properties -> Symbology ->Double 

click on the symbol-> select Octagon 1, Size 4, color bright pink. 
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c. Go to the toolbar Geoprocessing at the top of the program. Click 

Search for Tools.  Search for minimum bounding geometry and 

click it. 

i. In the box, make the Input Feature: FA7, the Geometry 

Type: CONVEX_HULL, Group Option: LIST, and Group 

Field: check the box Bear_id 

ii. Hit OK when done. It will take a few minutes to process but 

it will make a polygon around the bear’s data points, giving 

you a rough scope of its home range. 

iii. Once the new layer FA7_MinimumBoundingGeometry is in 

the table of contents, change the name of it to FA7 Home 

Range and open its Properties. 

iv. Change the symbology so the minimum bounding polygon has 

a fill color that matches the bear’s GPS points. Then hit OK.   

 MA8, MA11, MA13, MS6: 

a. Individually, make minimum convex polygon home ranges using 

minimum bounding geometry for each of the male bears using the 

steps described above for FA7. 

 

2. Time to look at time.  You can evaluate bear movements by date to get a better 

understanding of where AND when bears moved.  Let’s evaluate the bear MA8 first.   

 

a) Remove all layers except:  Yushan National Park.shp and MA8.shp (this is the 

file for the original data points for MA8, not the home range).  For MA8.shp, 

go to Properties and the tab Labels. Click the box: Label features in this 

layer, and change the Label Field: Date. Click OK. Examine the bear’s points in 

relation to the date to get a timeline of when and where it traveled.  

  

b) Use the same process to evaluate movement for each of the other 4 bears 

individually. 

  

c) Zoom to Yushan National Park.shp.  Add all 5 bear home ranges.  Did any 

bears leave Yushan National Park?  

 

3. Let’s measure each bear’s home range.  Use the Measure Tool and Measure By 

Feature.  Measure each home range in km2 and perimeters in km.  Place answers in 

the Questions section of the Student Pages. 
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4. Let’s see what elevations each bear used.  Make FA7.shp visible.  Click on table 

attributes. Right click on the elevation column and click Statistics. This will give you 

a statistic summary and graph.   

 

7. Make a map layout 

You will be making a poster about your findings from this study (look at STUDENT PAGES: 

Questions and Poster Presentations for details).   

Let’s make an example of a map layout that you might include in your poster.  

 For this map example, make the following layers visible: Taiwan Roads and Trails,Taiwan 

Water, the elevation layers, home ranges for all 5 bears, Yushan National Park. 

 Right click Yushan National Park in the table of contents, and click zoom to layer 

 Go to the View tab at the top of the program and click Layout View. A skinny layout window 

will pop up. Click the Change Layout button (the last button to the right has two little 

pages with an arrow). Under the Architectural Page Sizes tab choose ARCH A 

landscape.mxd.(8x12in) Click Finish. 

 Go to the Insert tab at the top of the program and click Legend. Have the Legend items 

only contain Home ranges, Yushan National Park, Taiwan Water and Taiwan Roads and 

Trails.  Click Finish. Move the legend to the bottom left of the map but not on the white 

border.  

 Double click on the Legend. In the Frame tab make the Background Color: white and the 

Gap X & Y: 2. Under the General tab unclick Show for the title. Under the Items tab click 

on Bears and then click Style below it. Scroll down the list to find the option called “ 

Horizontal Single Symbol Layer Name and Label” Click it and then Ok. Click OK when 

finished 

 Under the Insert tab click Title and name your map “ Asiatic Black Bears in Yushan 

National Park.” Click Ok when done.  

 Double click the title and change symbol to make the Text Size 24 and Font Arial Black. 

Click Ok when done.  

 Now your map is complete! Go to File: Export Map.  Name it and keep it as a JPEG. Save it 

to folder you can find again.  

 To go back to the data view with the table of contents and all your layers, go to the View 

tab and click Data View.  Make another map of your choosing! 
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Instructions for Hypothesis 2: Habitat Use 

By now you should have completed the GIS analyses to evaluate Hypothesis 1. 

 

Let’s move on to Hypothesis 2.  Go back and look at Hypothesis 2 again.  We need to evaluate 

habitat use by bears for different elevation ranges.  Remember during your GIS work that you 

classified the elevation ranges into 8 classes?  Dr. Mei Hwang did the exact same thing because 

she wanted to correlate elevation classes with different vegetation zones.  In Taiwan, here’s the 

general correlation between elevation and vegetation: 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Step 1:  Before we move on, it would be good to figure out the common names for each of the 

scientific names of plant species found in each zone.  Do a little research to figure that out and 

place results below: 

 

Machilus species: __________________________________________________________ 

 

Ficus species: _____________________________________________________________ 
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Castanopsis species: ________________________________________________________ 

 

Quercus species: __________________________________________________________ 

 

Tsuga species: ____________________________________________________________ 

 

Picea species: _____________________________________________________________ 

 

Abies species: ____________________________________________________________ 

 

What plants are normally found in alpine zones? ____________________________________ 

 

Asiatic black bears in Taiwan consume mainly succulent vegetation in spring (like young shoots of 

grasses), soft fruits in summer, and hard mast (e.g., acorns and nuts) in fall and winter.  Based on 

this information, which elevation zones do you think bears will use?  When do you think they will 

use these different elevation zones? 

________________________________________________________________________ 

 

________________________________________________________________________ 

 

________________________________________________________________________ 

 

Which zones do you think Asiatic black bears might not use?  Why?  

_______________________________________________________________________ 

 

_______________________________________________________________________ 

 

_______________________________________________________________________ 
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Step 2:  Let’s take a look at some data that Dr. Hwang collected.  Below, you will find Table 1.  

  

 

FEBRUARY-MAY   

Elevation zone (m) Proportion of bear locations SPRING 

0-500 9.5 

501-1000 33.2 

1001-1500 38 

1501-2000 13 

2001-2500 4.8 

2501-3000 0 

3001-3500 0 

3501-4000 0 

JUNE-SEPTEMBER   

Elevation zone (m) Proportion of bear locations SUMMER 

0-500 3.3 

501-1000 15.4 

1001-1500 40.5 

1501-2000 39 

2001-2500 10.2 

2501-3000 1 

3001-3500 0 

3501-4000 0 

OCTOBER-JANUARY   

Elevation zone (m) Proportion of bear locations FALL/WINTER 

0-500 0 

501-1000 1.7 

1001-1500 71 

1501-2000 20.5 

2001-2500 1.6 

2501-3000 1.3 

3001-3500 0 

3501-4000 0 

 
The light green part of Table 1 shows the percentage of all bear locations found in each elevation zone during 

summer. The light purple part shows the percentage of all bear locations found in each elevation zone during 

summer. The light gray part shows the percentage of all bear locations found in each elevation zone during 

fall.  For this analysis, locations for ALL 10 bears in this study were combined (instead of evaluating each 

bear individually).  For our home range analyses using GIS, we only evaluated 5 of these 10 bears, but for this 

analysis we included habitat use by all 10 bears. 

 

GRAPH IT!  Use the data in Table 1 to make 1 bar graph that shows differences in bear 

locations in different elevation zones during the 3 seasons.   

 

Table 1.  Seasonal differences in use of elevation zones (n = 220 locations) of Formosan black bears in Yushan National Park, 1998-2001. 
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Step 3:  Now, let’s take a swing at evaluating habitat selection for elevation zones by Formosan 

black bears.  When wildlife scientists evaluate habitat selection, they include estimates of both 

HABITAT USE and HABITAT AVAILABILITY.  Looks like we’ll need some additional data to 

determine whether or not Formosan black bears in Taiwan SELECTED different elevation zones.   

 

Before we do that, it’s important to remind you that the data set on Formosan black bears you will 

be using is small relative to many data sets from research studies on bears in the US and Europe 

(e.g., American black bears, brown bears, polar bears).  For the study that you are evaluating, Dr. 

Hwang and her crew were able to capture 15 bears.  For 5 of these bears, Dr. Hwang was not able 

to collect adequate location data for analyses.  Dr. Hwang was able to use bear location data from 

10 bears for her analyses.  You will evaluate 5 of those 10 bears.  Many North American scientists 

strive to collect data on at least 30 individuals of a population to meet statistical assumptions.  In 

this particular study, Dr. Hwang and her crew were limited by several constraints:   

 

1) the Formosan black bears have a very low population density so it is difficult to even find them 

2) the Formosan black bears are very wary so it’s difficult to catch them 

3) the rugged terrain makes it very difficult to hike into bear habitat and then track bears when 

they are collared 

 

What does this mean for you?  It means that your conclusions will be somewhat limited because 

there’s a lot of uncertainty when sample sizes are small (sample size for this study = the number of 

bears collared).  For this analyses, the sample size = 10 bears. 

 

We can still evaluate habitat selection, we just need to be careful with the strength of our 

conclusions.  Let’s take a look at a different table. 

 

This second table is a bit more involved, so we’ve placed it in an excel file for you.   

  Open the data file named “Data for students”  

  Look at the columns and rows.  Notice that some data are missing  

  It is your job to fill in these missing cell values in the excel table  

 

You will notice that you need to complete the values for “Ivlev’s Electivity Index” (Ivlev 1961), 

modified to make it symmetrical with respect to zero. This is an index of habitat selection.  It 

does not include estimates of error, like 95% confidence intervals.  In her analyses, Dr. Hwang DID 

evaluate habitat selection using Chesson selection indices, and she DID estimate confidence 

intervals for each value (i.e., estimates of error), but that type of analysis is beyond the scope of 

this lesson plan.  For our purposes, calculating Ivlev’s Index will provide results that are 

qualitatively similar to the results that Dr. Hwang found. 
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The Ivlev’s Index provides an index of habitat selection.  Here’s the equation: 

 

Ivlev’s Indexi = 2 x (Habitat Usei-Habitat Availabilityi) 

                        1 + (Habitat Usei + Habitat Availabilityi) 

 

For our analyses, the following terms are defined as: 

 Ivlev’s Indexi = habitat selection for habitat “i” 

 Habitat Usei = the proportion of total bear locations in elevation zone “i” 

 Habitat Availabilityi = the proportion of the total study area in elevation zone “i” 

 

When Ivlev Index = 1, this means the elevation zone was used in proportion to its 

availability.  When the value = 1, then bears neither selected nor avoided this zone. 

 

When Ivlev Index > 1, this means that the elevation zone was used more than it was 

available.  Bears selected this zone.  The higher the number, the more bears selected 

the zone. 

 

When Ivlev Index < 1, this means that the zone was used less than it was available.  

Bears avoided this zone.  The lower the number, the more bears avoided the zone. 

 

Okay!  You have enough information now to complete the cells in Table 2.  When you are done, move 

on to the “Student Pages:  Questions and Posters”. 
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